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File menu commands

The File menu offers the following commands:

Open Workspace Opens an existing PingTool workspace.
Save Workspace Saves the current workspace using the same file name.
Save Workspace As Saves the current workspace to a specified file name.
Exit Exits PingTool.



PingTool menu commands

Go! Performs all steps necessary to find the best servers for you.
Get Servers Lists Refreshes the server list by querying the master servers. 
Scan Servers Pings servers in the list quickly but doesn’t collect timing statistics
Time Servers Pings servers in the list more slowly and times the pings.
Ping Continouosly Causes PingTool to scan or time servers repeatedly.
Stop Network Activity Stops whatever PingTool is currently doing.
Apply Filter Toggles the server filter on and off.
Reset Server Stats Zeros out ping time statistics giving you a clean slate.
Find Player Searches the server list for a player.
Find Next Player Searches for a player again using the same search string.
Auto-Size Columns Automatically adjusts the widths all columns.
Select Server Fields Allows you to select what data to display in the server list.
Rearrange Columns Allows you to change the order that the columns in the tables appear.
Options Set various PingTool options.



View menu commands

The View menu offers the following commands:

Players Window Shows or hides the players window.
Master Servers Window Shows or hides the master servers window.
Server Variables 
Window 

Shows or hides the server variables window.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



Open Workspace command (File menu)

Use this command to open an existing PingTool workspace that you’ve previously saved. 

Shortcuts
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which PingTool stores the file that you want to open. 

Directories
Select the directory in which PingTool stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save Workspace command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, PingTool displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the Save 
As command.

Shortcuts
Keys: CTRL+S



Save Workspace As command (File menu)

Use this command to save and name the active document.    PingTool displays the Save As dialog box so 
you can name your document. 

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    PingTool adds the extension you specify in 
the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your PingTool session.    You can also use the Close command on the 
application Control menu.    PingTool prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in PingTool, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in PingTool,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Performs series of steps to find playable servers.

Refreshes the server list by querying the master servers.
 

Pings servers at the maximum rate.

Pings servers slow enough so that accurate ping time can be measured.

Toggles “Continuous Ping” mode.

Stops all network activity.

Applies the server filter.

Resets timing stats (e.g., avg ping) so you can start with a clean slate. 

Automatically resizes all columns so that data isn’t obscured.

Searches the current server list for a player.

Shows / Hides the Master Servers window.

Shows / hides the Players window.

Shows / hides the Server variables window.

Opens the Options dialog.



Activates the context help system.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the PingTool window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using PingTool and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of PingTool.



Context Help command 

Use the Context Help command to obtain help on some portion of PingTool.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the PingTool window, such as another Toolbar button.    The Help topic will be shown for the 
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the PingTool window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Find command (Edit menu)



Find dialog box



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Go!    (PingTool menu) 

The “Go!” feature performs all the steps necessary to provide you with an up to date list of servers 
running games that you’d be interested in joining.    When you click the “Go!” button PingTool performs the 
following steps:

1. Get Server Lists: this brings the server list up to date by querying the master servers.
2. Turns off the filter: this makes all active servers appear in the server list so they can be scanned..
3. Scans all servers: this pings all servers quickly to find out what’s happening.    This information can 

then be used to filter out servers that you’re not interested in.
4. Applies Filter: now that the status of all servers is known, this lets PingTool disregard servers that 

you’re not interested in.
5. Resets Server Statistics: when PingTool times the remaining servers it will be working with a clean 

slate.
6. Times the servers: this pings all the servers that passed the filter obtaining a realistic ping time for 

each of them.

When PingTool is done performing these steps, you’ll be looking at a list of all servers that you’d be 
interested in playing on with all the information you’d need to choose one that looks like it would be the 
most fun.    You can then sort by ping time, map, number of players or whatever. Or you could time some 
servers again and see which servers have the best average ping time.    You can launch QuakeWorld for a 
particular server by double clicking on it.

Toolbar:    



Get Server Lists    (PingTool menu)

This command refreshed the server list by querying the master servers. 

If there aren’t any master servers selected, all the master servers marked as “used” will be queried (i.e., 
those master servers that are set to “yes” in the “Use” column.)

If some of the master servers selected when you issue this command, only the selected ones will be 
queried.    This gives you manual control over what masters get queried.    See Selecting Rows for help on 
how to select masters.

Toolbar:    



Selecting Rows 

Some tables in PingTool allow you to “select” rows.      Then when you issue a command that normally is 
applied to the whole table, only the selected rows are used.    For example, if you want to ping only a few 
servers instead of the whole server list, you can select those servers and the click the Time-Servers 
button. 

Not all tables in PingTool allow you to select rows: only those that have a “row-button” or “row-header” 
which appears as a blank button on the far left side of the table.    When rows are selected they are 
highlighted using the default windows colors for selection.

You can select a single row by doing a left click on the row’s row-button.    You can select a range of rows 
buy holding down the left mouse button over a row-button and then dragging up or down across the range 
of rows.    You can select multiple individual rows by holding down the [CTRL] key while left clicking on 
row-buttons.

You can deselect all rows by simply clicking anywhere in the table except on a row button.



Scan Servers    (PingTool menu)

This command pings servers using the Scan Servers Options.    The intent is to find out what’s happening 
on a bunch of servers as quickly as possible.    It does this by querying as many servers concurrently as 
your internet connection can handle.      This is useful when you want to query a large number of servers 
to find out things like what mods they’re running, what levels and how many players are on.    Since ping 
times are not accurate when scanning servers, timing data is not collected.

If there are no servers selected when you issue this command, all servers in the visible list are pinged.    
Note that if the filter is applied when you issue this command, only the servers that are currently passing 
the filter are pinged.    To query all known servers you first have to turn off the filter. 

If there are some servers selected in the server list, only the selected servers are pinged.    This gives you 
manual control over what servers get pinged.      See Selecting Rows for help on how to select servers.

Toolbar:    



Time Servers    (PingTool menu)

This command pings servers using the Time Servers Options.    You use this command when you want to 
find out which servers have the best ping time from your computer.    In order to get accurate timings you 
have to configure PingTool to query only a few servers at a time.    You probably only want to time servers 
after you’ve scanned them and filtered out the ones you’re not interested in.

If there are no servers selected, all servers in the visible list are queried.    Note that if the filter is applied 
when you issue this command, only the servers that are currently passing the filter are pinged.

If there are some servers selected in the server list, only the selected servers are queried.    This gives 
you manual control over what servers get pinged.    After you’ve scanned and filtered the server list, you 
may want to re-ping the top few candidates by selecting them and then clicking Time Servers.    The “avg 
ping” column will tell you which ones are the absolute fastest.

Toolbar:    



Stop Network Activity    (PingTool menu)

Issue this command to stop PingTool from pinging whatever it’s currently pinging.    PingTool will remain in 
an idle state until you tell it to do something else.

Toolbar:    



Apply Filter    (PingTool menu)

This command allows you to toggle the server filter on and off.    See Filter Options for help on setting up 
the filter.

Toolbar:  



Reset Server Stats    (PingTool menu)

This command resets server statistics previously collected by PingTool.    This is useful if you want to 
discard statistics that are outdated or no longer relevant.    It gives you a “clean slate” before refreshing 
servers. 

The following server fields get reset:    Time Out %, Time Outs, Num Pings, Ave Ping

Toolbar: 



Auto-Size Columns    (PingTool menu)

This command causes PingTool to automatically adjust the widths of all the columns so that they are just 
wide enough to display the widest value.

Toolbar:    



Select Server Fields    (PingTool menu)

This command allows you to select what server fields appear in the server list.      If you add new fields to 
the table they will be added to the right hand side.    Once added you can rearrange the columns to your 
liking using the Rearrange Columns feature.



Rearrange Columns    (PingTool menu)

You may decide that you’d like to change the order of the columns in the various PingTool tables.    For 
example you want to have the columns that are most important appear to the left of the less important 
ones so that you don’t have to scroll right to see them.

When this item has a check mark next to it PingTool is in “rearrange columns” mode.    In “rearrange 
columns” mode, clicking on a column header “selects” the column instead of sorting the table by that 
column.    Once a column is selected, you can move it to a new position by dragging the header to a new 
location.    As you drag you’ll see a vertical dotted line representing the place where the column will be 
move to.    Releasing the mouse button will move the selected columns to the new position.



Options    (PingTool menu)

This command activates the options dialog:

Time Servers Setting used when timing servers.
Scan Servers Setting used when scanning servers.
Launching QW The command line used to launch the QuakeWorld client.
Filter Filter settings.

Toolbar:    



Show Players    (View menu)

This shows / hides the players window.

Toolbar: 



Show Master Servers    (View menu)

This shows / hides the master servers window.

Toolbar:    



Time Servers      (Options dialog)

These settings are used when PingTool is timimg servers . 

· Number Of Simultaneous Pings:    The maximum number of queries pending at any given time.
· Number Of Retries:    If a ping times out, the number of times to retry the query.
· Milleseconds before ping times out:    How long PingTool should wait before it assumes that the server 

isn’t going to respond.

The the most important setting is the Number of Simultaneous Pings.    It’s important to keep this number 
relatively low, especially for modem users.    If you set ths to 1, only one server gets pinged at a time.    
This will yield the most accurate ping times, however it will also take a relatively long time to ping many 
servers.    If this value is set to high too many server responses will arrive at ISP at the same time and will 
have to “wait in line” before getting squeezed through your modem.    Ping times will become inflated.

0 A value of 3 or 4 is a good compromise.    The lower the number the more accurate the ping times will 
be.    The higher the number the faster it will refresh the server list, but the less accureate the ping times 
will be.



Scan Servers      (Options dialog)

These settings are used when PingTool is scanning servers . 

· Number Of Simultaneous Pings:    The maximum number of queries pending at any given time.
· Number Of Retries:    If a ping times out, the number of times to retry the query.
· Milleseconds before ping times out:    How long PingTool should wait before it assumes that the server 

isn’t going to respond.

0 You should set the “Number of Simultaneous Pings” just high enough so that server responses are 
coming in as fast as your internet connection can handle them.    Setting this value too high will cause 
PingTool to ping too many servers at the same time.    Server responses will get queued up on your ISP 
side of the link waiting for their turn to be sent through your modem connection and ping times will 
become greatly inflated.    If while scanning servers you notice that almost all the servers are timing out, 
you should lower this value.

1 A good way to adjust this value is to watch the status bar as you scan servers, taking note of the # of 
servers per second.    You should experiment by increase the “Number of Simultaneous Pings.”    If you 
see a gain in the number of servers processed per second, try increasing Number of Simultaneous Pings 
again.    Keep increasing it until you no longer see a gain.    Then you’ll know you’re at the limit of what 
your modem can handle.

2 You may also notice that during “prime time” internet hours your ISP won’t be able to give you as 
many servers per second as during non peak hours.

3 It may also be usefull to use a data rate monitoring tool while adjusting the number Number of 
Simultaneous Pings.    For example, under WinNT you can use Performance Monitor.    Under Win 95 you 
can use SysMon, but you’ll have to install the “Dial Up Networking 1.2” patch available for free from 
Microsoft. 



Launching QW    (Options dialog)

This is the command line PingTool will use when launching your QuakeWorld client.    Since PingTool isn’t 
a “Quake World Front End” like QSpy is, you’ll have to configure everything yourself in a configuration 
script. 

· Quake Sub-Directory:    This is the location on your hard drive where your Quake files are.    Typically 
this is something like C:\QUAKE.

· QuakeWorld command line:    This is the command line used to launch the QuakeWorld client. (QWCL 
or GLQWCL). 



Filter      (Options dialog)

This lets you configure the criteria used to filter out unwanted servers. 



How To Launch QuakeWorld

After you’ve decided on a server that you’d like to join, simply double click on it in the server list.    
PingTool will use the command line configured in the options dialog to launch you QuakeWorld client.



How To Rearrange Windows

Except for the Server List, all windows in PingTool can be hidden if you don’t want them cluttering up your 
screen.    You can also resize them with the splitter bars.    They can also be “floated” or “docked” in 
different positions. This creates a highly customizable workspace. 

To float and re-dock a window, you have to “grab” the window by the thin border just inside the splitter bar. 
Note the position of the mouse cursor below::

0 As you drag the window you will see on outline of where the window will be when you release the 
mouse button.    To “dock” the window on a different edge, drag the mouse pointer to that edge and then 
release the button.    Once the window is docked you can resize it using the splitter bar.



Players Window

This window displays player information for the current server.    It contains the following fields:

Name: The name of the player.
Skin: The filename of the skin the player’s using.
Frags: The number of frags or points the player has.
Connect: The number of minutes the player’s been connected on the current map.
Ping: The player’s ping time.
Shirt: The shirt color of the player (sorry, no WYSIWYG preview in PingTime yet!).
Pants: The shirt color of the player.

You can show or hide this window using the Show Players Window command. 

You Re-dock this window to different positions in the PingTool workspace (see How To Rearrange 
Windows ). 

You can re-arrange the order of the columns with the Rearrange Columns command.



Master Servers Window

This window displays the Master Servers list.    These servers are imported from the MASTER.DAT file the 
first time you start PingTool.

It has the following fields:

· Use:    This is a column of buttons that allow you to “turn off” a master.    When a master server is in 
use, it’s QuakeWorld servers are included in the server list.    Also, the master server gets queried 
when you do a “Get Server Lists” command from the PingTool menu.

· Master IP:    This is the internet address of the master server.
· Name:    The name the master is commonly referred as.
· Num Servers:    The number of servers in this master’s server list.
· Last updated:    The time the last server list was received from the master.

You can show or hide this window using the Show Master Server command. 

You Re-dock this window to different positions in the PingTool workspace (see How To Rearrange 
Windows ). 

You can re-arrange the order of the columns with the Rearrange Columns command. 



Server List

This window displays the current list of servers. 

You can sort by any column by clicking on its header.    You can reverse the direction of the sort by 
clicking on the same column header again.    You’ll know which column is the current sort column because 
the text in the header is underlined.

You can add or remove columns to this table with Select Server Fields. 

You can re-arrange the order of the columns with the Rearrange Columns command.



Getting Started

First you should review the PingTool options via the Options command. The defaults for Time Servers and 
Scan Servers should work well for you if you’re a modem user.    However you should double check the 
Launching QW options and the Filter options.

You should also tell PingTool what master servers you plan to use by clicking the Use buttons in the 
Master Window .    (E. g., if you live in North America, you probably won’t want to use Australia’s master).

When you’ve got everything configured, just click  and get ready to frag.



Pinging Just A Few Servers

If there’s nothing “selected” in the server list, PingTool will ping the entire server list.    To ping just a few 
servers instead of the entire server list, simply select the ones you want to ping and either click Time 
Servers or Scan Servers.    Only the selected servers will be pinged.



Find Player (PingTool menu)

The Find Players command lets you search for a player in the current server list.    PingTool will display 
the Find Player Dialog allowing you to type in or choose the player name you want to search for.    
PingTool will then search the server list starting at the top.    If a player name is found that contains the 
search string you’ve entered PingTool will scroll to that server in the Server List.

Note that PingTool will only search servers in the current server list.    If the filter is currently applied, only 
servers that currently pass the filter are searched. 

If the search string you’ve entered doesn’t match any players and the filter is applied, PingTool will ask 
you if you’d like to search again with the filter turned off.

Shortcuts

Toolbar: 

Keys: CTRL+F



Find Next Player 

The Find Next Player command lets you search the server list again for a player.    It uses the same 
search string that you used last time you searched.    This is useful if you want to search repeatedly using 
the same search string.

Shortcuts
Keys: F3



Find Player Dialog

You activate this dialog with a Find Player command. 

The Find Player dialog lets you enter a search string when searching the server list for players.    You can 
either type in a search string or choose a recently used search string from the drop down list box (by 
clicking the down arrow on the right).



Ping Continuously

This command allows you to toggle the Ping Continuously mode on and off.    When activated, this option 
will cause PingTool to repeat it’s last server ping operation over and over.    This can be usefull, for 
example, to monitor one or more servers over a period of time.    Another example is to do a “Time 
Servers” command with “Ping Continuously” activated.    This averages ping times over an extended 
period allowing you to determine very accurate ping times averages.

Shortcuts

Toolbar: 



Show Server Variables window

This command shows / hides the server variables window.

Toolbar:    



Server Variables Window

This window displays all server variables for the current server. 

You can show or hide this window using the Show Servers Variables Window command. 

You Re-dock this window to different positions in the PingTool workspace (see How To Rearrange 
Windows ). 




